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Planning for Confluence 4.0
Use this page as a one-stop-shop to help you prepare for Confluence 4.0 and its new editor.

Try Confluence 4.0!

Download or trial .Confluence 4.0 here

Customer Webinar

Atlassian will be running a webinar on Confluence 4.0. See the  for more information.planning page

Confluence 4.0 Guides

For Administrators

We've been working hard to make your life easier upgrading to Confluence 4.0. Here are some resources to help:

Confluence 4.0 Release Notes
Quick Administrator Tips To Prepare for Confluence 4.0
Summit 2011 Talk - on upgrading to Confluence 4.0
Summit 2011 Talk - Confluence 4 State of the Union
Confluence 4.0 Editor FAQ
Trying Confluence 4.0 Yourself
Wiki Markup to XHTML Migration

For Plugin Developers

Plugin developers - check out the guides we've created for you to help you migrate your plugins to 4.0:

Preparing for Confluence 4.0
Macro Tutorials for Confluence 4.0 (including new macro plugin points)
Plugin points for the editor in 4.0
Plugin Development Upgrade FAQ for 4.0
Watch a webinar on preparing plugins for 4.0
Atlascamp 2010 - Confluence 4.0 Plugin Migration Talk
Trying Confluence 4.0 Yourself
Changes to the remote API in Confluence 4.0

For Users

To make the transition easier to Confluence 4.0, we've created some guides for you:

Quick Reference Guide for the Confluence Editor
What's Changed for Wiki Markup Users
What's Changed for Users of the Old Rich Text Editor
Trying Confluence 4.0 Yourself
Confluence 4.0 Editor FAQ

Need help upgrading? Don't forget  that can help you with your upgrade.Atlassian has a large list of partners
Please refer to your  page for latest information on how to resolve issues specificHave problems? Confluence 4.0 Known Issues

to this release.

Confluence 4.0 Editor FAQ
Confluence 4.0 introduces a new editor. We first made this announcement at Atlassian Summit in June 2010.

This page contains answers to common questions about the move to the Confluence 4.0 editor.

http://www.atlassian.com/software/confluence/try.jsp
https://www2.gotomeeting.com/register/366915714
https://www2.gotomeeting.com/register/366915714
http://summit.atlassian.com/archives/admins/preparing-for-confluence-upgrade
http://www.youtube.com/watch?v=gVa_H3z_BTg#t=15m10s
http://confluence.atlassian.com/display/CONFDEV/Plugin+Development+Upgrade+FAQ+for+4.0
http://confluence.atlassian.com/download/attachments/224397662/4.0Webinar.mov?version=1&amp;modificationDate=1298423957436
http://www.atlassian.com/en/about/events/atlascamp/2010/day1/confluence-macro-migration-guide
https://developer.atlassian.com/display/CONFDEV/Changes+to+the+remote+API+in+Confluence+4.0
http://confluence.atlassian.com/display/APW/Partner+Directory+Home
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How can I stay informed about the progress of the new Confluence 4.0 editor?
Here are some things you can do to keep up with the news about the Confluence 4.0 editor:

Watch the  page, and any other pages you like, if you would like Confluence to send you an email whenConfluence 4.0 Editor FAQ
we update the page.
To watch a page, sign up for a username on this documentation wiki if you do not already have one, then open the ' ' menu onTools
the page and click ' '.Watch
Sign up to the Confluence User Task Force.
 What is the User Task Force? Click here to expand the section below...
The purpose of this user task force is to give you the opportunity to provide a more detailed level of feedback on Confluence as a
product. This will help us learn more about our market and better meet your needs. Members of the task force would be asked to
participate in such things as:

General surveys on Confluence use cases, features and ideas.
Feedback on early releases of the product.
Usability and user experience testing.

How often would you be asked to participate? As a general rule we won’t be asking you to participate any more than once a month.

We will notify all members of the Confluence User Task Force once the new editor is available for feedback. .You can sign up here

Why is Atlassian introducing a new editor in 4.0?

The editor is the single most important feature in Confluence. Confluence 3.5 has two editors: the rich text editor and the wiki markup editor.
Each has its strong points and weak points.

The rich text editor in particular has problems in stability and consistency, because it has to convert all content from rich text to wiki
markup before storing content on the database. This leads to the so-called 'round-tripping' problems, where the page looks different
in display mode than when created in edit mode.
Many people find the wiki markup editor hard to use, particularly for long pages and complex layouts. We often hear from customers
that the number one barrier to wiki adoption in their organisation is that people have to learn wiki markup.

Many customers have given us great feedback on the shortcomings of the current editors and the things they would like to see in a
Confluence editor. We are introducing a single new editor to replace both the wiki markup editor and the rich text editor. The new editor will
help us to solve the problems mentioned above and will provide a stable platform on which we can build high-demand features in future
releases.

On this page:

How can I stay informed about the progress of the new Confluence 4.0 editor?
Why is Atlassian introducing a new editor in 4.0?
What about features that were previously available only in wiki markup?
So you are basically eliminating the wiki markup editor and keeping the rich text editor?
Will you be able to paste wiki markup into the new Confluence editor?
Will Confluence 4.0 support the Office Connector, including 'Edit Page in Word' functionality?
In Confluence 4.0, will you be able to merge and split table cells?
When will the new editor appear in Confluence?
What does the new editor look like?
Will Confluence still have a wiki markup editor?
What format will Confluence use to store its page content?
Will you be able to edit the source XHTML code directly?
Will there be a tool to convert existing content from wiki markup to the new XHTML format?
Will there be any API changes?
How many Confluence 3.x releases will you have before 4.0?
Will the remote XML-RPC API still work in Confluence 4.0?
Will the new editor be included in JIRA?
Does the SharePoint Connector support Confluence 4.0?

What about features that were previously available only in wiki markup?

We have identified these features and will add support for as many as possible in the new editor. For example, the new editor will include
superscript and subscript text formatting, which is currently not available in the Confluence 3.5 rich text editor.

So you are basically eliminating the wiki markup editor and keeping the rich text
editor?

No. While the new editor is WYSIWYG like the current rich text editor, the new editor has a completely different architecture based on
XHTML and is faster and significantly more reliable. Our goal is to incorporate the strengths of wiki markup with the richness and
intuitiveness of the WYSIWYG editor to produce a rich, hybrid editing experience. In particular, we are introducing options that offer the
speed of the old wiki markup editor, via new features such as autocomplete and shortcut keys.

http://atlss.in/task4rce
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Will you be able to paste wiki markup into the new Confluence editor?

There will be multiple ways to insert wiki markup in the new editor.

For those of you that have learned wiki markup and are used to the speed of wiki markup we are really excited to let you know that you will
still be able to write wiki markup in the new editor. This wiki markup converts 'on the fly', providing one of the fastest editing experiences yet.

For those of you that have scripts that produce wiki markup, or often write wiki markup in meetings, the new Confluence 4.0 editor introduces
an  dialog which will let you paste wiki markup for a one-way conversion.Insert > Wiki markup

Will Confluence 4.0 support the Office Connector, including 'Edit Page in Word'
functionality?

Most of the features of the Office Connector (the View File macros, Import from Word) already work in 4.0. However, the 'Edit in Word'
feature will be removed in Confluence 4.0. 

When speaking to customers about the use of the 'Edit in Word' functionality, the  for using this feature was 'familiarity'.primary reason
Business users in organisations have found the 3.5 editor and wiki markup hard to learn.

In Confluence 4.0, we have greatly simplified the new editor user interface. With extensive usability testing, we are confident the new editor
will be easier to learn and more reliable to use. We also have a large majority of customers who do not use the 'Edit in Word' functionality.

Please Note: We are referring to the "Edit Page in Word" functionally - not the "Edit Attachment in Word" functionality. Editing attachments in
Word will still work fine, i.e. launching Word to edit Word documents that are stored in Confluence.

In Confluence 4.0, will you be able to merge and split table cells?

Yes, you will be able to merge and split table cells. This is a brand new feature in Confluence 4.0.

When will the new editor appear in Confluence?

The new editor is in Confluence 4.0, scheduled for release in 2011.

What does the new editor look like?

Confluence 4 is currently available for download through our Early Access Program. You can download and try the new editor for yourself.
This is a great opportunity to provide early feedback to us. More details .about this here
You can also watch a video preview of Confluence 4 from our Atlassian Summit in June 2011. Watch the video at this link
(hhttp://www.youtube.com/watch?v=gVa_H3z_BTg#t=15m10s).

Will Confluence still have a wiki markup editor?

No. The vision is incorporating the best parts of the wiki markup editor into the new editor to provide the best of both worlds.

What format will Confluence use to store its page content?

XHTML. Up to now, Confluence has stored its content in the database as wiki markup. In Confluence 4.0, the content will be stored as
XHTML. Basically, XHTML is like HTML but complies with stricter formatting rules. Where HTML is based on SGML, XHTML is based on
XML, which is a subset of SGML. Because XHTML documents need to be well formed, they can be parsed using standard XML parsers.

Will you be able to edit the source XHTML code directly?

Confluence 4.0 will not have an "edit XHTML source" mode. More sophisticated macro placeholders, images and link handling in Confluence
4.0 entail a lot of custom XHTML which make the new storage format much more complex than standard HTML. Editing this storage format
by hand could result in corrupt content and the loss of page data. Source editing will still be editable via the APIs and the WebDAV client.

Will there be a tool to convert existing content from wiki markup to the new XHTML
format?

Yes. Where possible, Confluence will automatically upgrade existing content into the new XHTML storage format. There will be some API
changes (we are trying to keep these to a minimum) and we will provide mechanisms to convert wiki markup to XHTML.

Read the  or   to learn more about API changes.Plugin Development Upgrade FAQ for 4.0 Planning for Confluence 4.0

Will there be any API changes?

https://developer.atlassian.com/display/CONFDEV/Plugin+Development+Upgrade+FAQ+for+4.0
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1.  

2.  
3.  

Yes. There will be some API changes (we are trying to keep these to a minimum) and we will provide mechanisms to convert wiki markup to
XHTML.

Read the  or   to learn more about API changes.Plugin Development Upgrade FAQ for 4.0 Planning for Confluence 4.0

How many Confluence 3.x releases will you have before 4.0?

There will be no more 3.x releases before 4.0. Confluence 3.5 is our last 3.x release.

Will the remote XML-RPC API still work in Confluence 4.0?

We currently plan to keep the existing XML-RPC API but only allow write access which will automatically convert wiki markup to XHTML. This
will allow you to create new pages or update existing pages as usual. We can't allow read access, however, because we can only return
XHTML, which will break the existing APIs contract of returning wiki markup. To cover those use cases and to have a fully XHTML capable
API, we will introduce a new API available through a separate URL which will also have a new method to migrate wiki markup to XHTML.

Developers should read  to learn more about API changes.Preparing for Confluence 4.0

Will the new editor be included in JIRA?

At the moment we don't have any plans to do this. However, we are open to this idea and would welcome any customer feedback in this
area.

Does the SharePoint Connector support Confluence 4.0?

We are working to add Confluence 4.0 support to the SharePoint connector. We plan to have a 4.0-compatible version at some point in the
future.

 

RELATED TOPICS

A developer's guide to preparing for Confluence 4.0

Confluence 4.0 Editor - What's Changed for Users of the Old Rich
Text Editor
This page is a quick-reference guide describing the changes to the editor in Confluence 4.0, showing you how to perform your day-to-day
tasks in the new editor. This guide is for people who regularly used the Rich Text Editor in earlier versions of Confluence.

On this page:

How to Get Started Quickly
Before and After Guide

Using Old Rich Text Editor
Adding Macros
Formatting Text
Adding Symbols and Emoticons
Linking text
Using bulleted and numbered lists
Using tables
Displaying images
Embedding multimedia files

Functionality that is No Longer Available

How to Get Started Quickly

Try the commands and menus you know from the old Rich Text Editor. The new editor incorporates much of the existing
functionality.

Learn the keyboard shortcuts. Click the help icon  on the editor toolbar to see a list of keyboard shortcuts.
Undo the autocomplete and autoformat actions. To undo something that autocomplete or autoformat has done, press 

 on your keyboard. Alternatively, press  (Windows) or  (Mac).Backspace Ctrl+Z Cmd+Z

Before and After Guide

Below are the most commonly used RTE menu options and how they play into the new editor menu.

https://developer.atlassian.com/display/CONFDEV/Plugin+Development+Upgrade+FAQ+for+4.0
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Using Old Rich Text Editor

What You Did Before What to Do Now

Basic typing and editing:
Typed your content directly into
the editor window, using the
toolbar buttons to insert other
content.

Your experience should be much the same. Generally, the transition from using the Confluence 3.5
Rich Text Editor to the new Confluence 4.0 editor should be smooth. Try doing things the way you
always did, and check the table below if you can't find the feature you're looking for.

Adding Macros

What you did before What to do now (press Enter to complete actions)

Adding a macro to
your page: 
Clicked 'Insert / Edit

'.Macro

Type ' ' and start typing the macro name to see a list of macros that match your text. Press the arrow keys to{
select the macro you want. Example:

 

 You can still click ' '  ' '.Insert > Other Macros

Formatting Text

What you did before What to do now

Making text bold,  or italic underlined:
Selected text and clicked the respective menu
button.

No change.

Heading levels:
Selected text and chose a heading level from the
menu.

No change.

Left, centre and right alignment:
Not available in previous versions of Confluence.

Click the left, centre and right alignment buttons on the editor toolbar:

 This can also be used to align images independently of text.

Indentation:
Click the left and right indentation buttons on the
editor toolbar:

No change. Click the left and right indentation buttons on the editor toolbar:
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Making text , monospace,strikethrough
superscript or subscript:
Selected text and clicked the respective menu
button.

Click this button on the editor toolbar and select from the drop-down list. Example:

Quoting text:
Selected text and chose the ' ' style fromQuote
the drop-down menu.

No change: Use the  style – select ' ' from the style dropdown menu orQuote Quote
use the keyboard shortcut. Example:

Changing text colour:
Selected text and chose a colour from the menu
bar.

No change: Click the colour options on the editor toolbar. Example:

Adding Symbols and Emoticons

What you did before What to do now

Smiley:
Clicked ' '  'Insert >

' on the toolbar. Emoticon

Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and
round bracket), and so on. Autocomplete will convert it as you type. Example:

:)

 You can still click ' '  ' ' on the toolbar.Insert > Emoticon
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Tick or check mark:
Clicked ' '  'Insert >

'  .Emoticon >

Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:

(/)

 You can still click ' '  ' '  .Insert > Emoticon >

Linking text

What you did before What to do now (press Enter to complete actions)

Linking to a Confluence page:
Clicked ' '  ' ' on the toolbar.Insert > Link

Type a square bracket ' ' and start typing the page name to see the suggested pages[
to link to. Press the arrow keys to select the page you want. Example:

 

 You can still click ' ' on the toolbar.Link

Linking text to a web page:
Selected the text and clicked ' '  'Link > Web Link
' on the toolbar and typed the URL into the
dialog box. }

Type a square bracket ' ' and select ' ', then paste the URL into the[ Insert Web Link
link dialog. Example:

 

 You can still use ' '  ' ' on the toolbar.Link > Web Link

Linking to a page that does not yet exist:
Not available in previous versions of
Confluence.

Type a square bracket ' ' and the name of the non-existent page, then select '[ Insert
'. Example:Link to Create Page

Linking to a  linkmailto : 
Clicked ' '  ' ' on the toolbar andLink > Web Link
typed

mailto:username@example.com

 

No change. 
You still click ' '  ' ' on the toolbar and typeLink > Web Link

mailto:username@example.com
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Linking to an anchor on a page:
Clicked ' '  ' ' on the toolbar andLink > Web Link
typed ' '.DestinationPage#AnchorName

No change. 
You still click ' '  ' ' on the toolbar and type 'Link > Web Link

'.DestinationPage#AnchorName

Linking to an attachment:
Clicked ' '  ' ' on the toolbar.Link > Attachment

Type a square bracket ' ' and start typing the attachment name to see the suggested[
attachments to link to. Press the arrow keys to select the item you want. Example:

 

 You can still click ' '  ' ' on the toolbar.Link > Attachment

Using bulleted and numbered lists

What you did before What to do now (press Enter to complete actions)

Adding bullets:
Clicked ' ' on theUnordered List
toolbar.

Type an asterisk '*' followed by a space. Autoformat will convert the line to a bulleted list. You can
continue typing your text immediately. Example:

 To add another line of text to an entry without creating a new list item, press Shift + Enter at the
end of the line.

 You can still click ' ' on the toolbar.Bullet List

Adding numbered items:
Clicked ' ' on theOrdered List
toolbar.

Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list. You
can continue typing your text immediately. Example:

 To add another line of text to an entry without creating a new list item, press Shift + Enter at the
end of the line. 

 You can still click ' ' on the toolbar.Numbered List

Adding line breaks in a
numbered/bulleted list:
Pressed .Shift+Enter

No change. You can still press .Shift+Enter

Using tables

What you did before What to do now
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Adding a table:
Clicked ' ' onInsert Table
the toolbar.

Type a series of pipe characters '|' then press . Autoformat will convert the pipes to a table. ExampleEnter
– to create a table with three columns:

| | | |

 You can still click ' '  ' ' on the toolbar.Insert > Table

Editing a table:
Used the table buttons on
the toolbar.

No change, you can still use the toolbar table editing controls, with new features such as table merge and
split.

Displaying images

What you did before What to do now (press Enter to complete actions)

Displayed an image attached to the page:
Typed/pasted the image name inside
exclamation marks '!'. Example:

!NoMatterWhat.png!

Type an exclamation mark ' ' and start typing the image name to see the suggested!
images to insert onto the page. Press the arrow keys to select the item you want.
Example:

Displaying an image attached to another
page:
Clicked ' '  ' ' andInsert Image > From the Web
inserted the URL of the image on the other
page.

Click ' '  ' ' and type search terms to find the image in Confluence. OnceInsert > Search
found, click the image and it will be added to the page.

Embedding multimedia files

What you did before What to do now (press Enter to complete actions)
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1.  

Embedding a video, movie or audio file into a page:
Clicked ' '  ' '  ' ' and choseInsert > Macro > Multimedia Macro
content from the browser.

Use the Multimedia macro. Type an exclamation mark ' ' and select!
'Insert Other Media'. Example:

Or type ' ' and start typing the macro name 'Multimedia'. Example:{

Functionality that is No Longer Available

This section contains a list of things you could do in in earlier versions of Confluence, but can no longer do in Confluence 4.0.

Edit a page in Microsoft Word. See .FAQ entry

RELATED TOPICS

Planning for Confluence 4.0

Confluence 4.0 Editor - What's Changed for Wiki Markup Users
This quick-reference guide is for people who regularly used the wiki markup editor in earlier versions of Confluence. It shows you how to use
the new editor to do the things you have always done. And more.

The editor offers a number of options in the toolbar. But did you know...?

You can use autocomplete and autoformatting shortcuts instead of the toolbar.
The trigger characters are derived from wiki markup!

On this page:

Hints to Get You Started Quickly
Before and After Guide for Wiki Markup Fans

Using Wiki Markup
Adding Macros
Formatting Text
Adding Symbols and Emoticons
Linking text
Using bulleted and numbered lists
Using tables
Displaying images
Embedding multimedia files

Functionality that is No Longer Available
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1.  

2.  
3.  

Hints to Get You Started Quickly

Type wiki markup into the editor. Confluence's autocomplete and autoformat will convert the wiki markup as you type.

Learn the keyboard shortcuts. Click the help icon  on the editor toolbar to see a list of keyboard shortcuts.
Undo the autocomplete and autoformat actions. To undo something that autocomplete or autoformat has done, press 

 on your keyboard. Alternatively, press  (Windows) or  (Mac).Backspace Ctrl+Z Cmd+Z

Before and After Guide for Wiki Markup Fans

Below are the most commonly used autocomplete and autoformatting triggers.

Using Wiki Markup

What You Did Before What to Do Now

Typing wiki markup:
Typed text and wiki markup
into the Wiki Markup Editor
pane.

Start typing wiki markup – try it and see what happens!

Pasting wiki markup:
Pasted wiki markup into the
Wiki Markup Editor pane.

Click ' ' > ' ' on the editor toolbar.  Confluence will convert the wiki markup to richInsert Wiki Markup Note:
text as soon as you add it to your page. The wiki markup will not be available for editing after that.
Example:

Adding Macros

What you did before What to do now (press Enter to complete actions)

Adding a macro to your page:
Typed curly brackets, the macro name
and parameters. Example:

{blog-posts}

Type ' ' and start typing the macro name to see a list of macros that match your text. Press{
the arrow keys to select the macro you want. Example:

Formatting Text

What you did before What to do now
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Bold text:
Typed an asterisk '*', your text, then
another asterisk in wiki markup.
Example:

*Surf's Up*

Type an asterisk '*', your text, then another asterisk. Confluence autoformat will convert the
text to bold immediately. Example:

*Surf's Up*

Heading levels:
Typed the heading level in wiki markup.
Example:

h2. Midnight at the Lost and
Found

Type the heading level and a full stop. Autoformat will convert the line to the appropriate
heading immediately. You can continue typing your heading text immediately. Example:

h2.

Underlining, italics, superscript,
subscript:
Typed the wiki markup characters before
and after your text.

Type the wiki markup just as you did before. Autoformatting will convert it as you type.

Left, centre and right alignment:
Not available in previous versions of
Confluence.

Click the left, centre and right alignment buttons on the editor toolbar:

 This can also be used to align images independently of text.

Indentation:
Not available in previous versions of
Confluence.

Click the left and right indentation buttons on the editor toolbar:

Quotation:
Typed the {quote} macro in wiki markup.
Example:

{quote}Life is a lemon.{quote}

Use the  style – select ' ' from the style dropdown menu or use the keyboardQuote Quote
shortcut. Example:

Or type bq. in the editor

Colour:
Typed the {color} macro in wiki markup.
Example:

{color:green}Bat out of
Hell.{color}

Click the colour options on the editor toolbar. Example:
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Adding Symbols and Emoticons

What you did before What to do now

Smiley:
Typed a colon and a round
bracket. Example:

:)

Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and
round bracket), and so on. Autocomplete will convert it as you type. Example:

:)

Tick or check mark:
Typed a forward slash in
round brackets. Example:

(/)

Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:

(/)

Linking text

What you did before What to do now (press Enter to complete actions)

Linking to a Confluence page:
Typed the text and pasted the page name
inside square brackets. Example:

[Modern Girl|Modern Girl song
lyrics]

Type a square bracket ' ' and start typing the page name to see the suggested pages to[
link to. Press the arrow keys to select the page you want. Example:

Linking text to a web page:
Typed the text and pasted the link inside
square brackets. Example:

[Modern
Girl|http://www.example.com/song]

Type a square bracket ' ' and select ' ', then paste the URL into the link[ Insert Web Link
dialog. Example:

Linking to a page that does not yet exist:
Typed the name of the non-existent page
inside square brackets. Example:

[Future of the Modern Girl]

Type a square bracket ' ' and the name of the non-existent page, then select '[ Insert
'. Example:Link to Create Page
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Linking to an attachment:
Typed '^' and the attachment name inside
square brackets. Examples:

[^attachment name]
[Page Name#^attachment name]

Type a square bracket ' ' and start typing the attachment name to see the suggested[
attachments to link to. Press the arrow keys to select the item you want. Example:

Using bulleted and numbered lists

What you did before What to do now (press Enter to complete actions)

Adding bullets:
Typed an asterisk '*' in wiki markup.
Example:

My list:
* Bad Attitude

Type an asterisk '*' followed by a space. Autoformat will convert the line to a bulleted list. You
can continue typing your text immediately. Example:

 To add another line of text to an entry without creating a new list item, press Shift + Enter
at the end of the line.

Adding numbered items:
Typed a hash '#' in wiki markup.
Example:

My list:
# A Time for Heroes

Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered
list. You can continue typing your text immediately. Example:

 To add another line of text to an entry without creating a new list item, press Shift + Enter
at the end of the line.

Adding line breaks in a
numbered/bulleted list:
Started a new line. Typed a double slash
for an empty line. Example:

//

Press .Shift+Enter

Using tables

What you did before What to do now (press Enter to complete actions)

Adding a table:
Typed pipe characters '|' in wiki
markup. Example:

||  || Title || Owned ||
| 1  |  45 seconds of
ecstasy | Y |
| 2  |  Amnesty Is Granted
|   |

Type a series of pipe characters '|' then press . Autoformat will convert the pipes to a table.Enter
Example – to create a table with three columns:

| | | |

Editing a table:
Edited the text and shuffled the pipe
characters around.

Learn the keyboard shortcuts for table editing. Click the help icon  on the editor toolbar to
see a list of shortcut keys.
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Displaying images

What you did before What to do now (press Enter to complete actions)

Displayed an image attached to the page:
Typed/pasted the image name inside exclamation marks '!'.
Example:

!NoMatterWhat.png!

Type an exclamation mark ' ' and start typing the image name to see!
the suggested images to insert onto the page. Press the arrow keys
to select the item you want. Example:

Displaying an image attached to another page:
Typed/pasted the page name, a '^' and the image name inside
exclamation marks. Example – to display an image that is
attached to the page titled 'Home By Now':

!Home By Now^NoMatterWhat.png!

Exactly the same as when the image is attached to the same page,
or use the new "Search" tab in "Insert" > "Image"

Aligning images:

!NoMatterWhat.png|align=right!

Click on the image and then:

Click the left, centre and right alignment buttons on the editor toolbar:

 This can also be used to align images independently of text.

Embedding multimedia files

What you did before What to do now (press Enter to complete actions)
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Embedding a video, movie or audio file into
a page:
Used the wiki markup image format. Example:

!HotPatootie.mov!

Use the Multimedia macro. Type an exclamation mark ' ' and select 'Insert Other!
Media'. Example:

Or type ' ' and start typing the macro name 'Multimedia'. Example:{

Functionality that is No Longer Available

This section contains a list of things you could do in in earlier versions of Confluence, but can no longer do in Confluence 4.0.

Things you cannot do in Confluence 4.0:

Edit a page in Microsoft Word. See .FAQ entry

RELATED TOPICS

 Using Autocomplete
Keyboard Shortcuts
Planning for Confluence 4.0

Quick Administrator Tips To Prepare for Confluence 4.0
We've put together some quick tips on how Administrators can prepare for Confluence 4.0:

1. Stay Updated On The Latest Docs

Watch the  page. We will update that page with more resources as we make further progress -  so make sure youPlanning for Confluence 4.0
stay updated!

2. Download, install and trial Confluence 4.0

We strongly encourage you to set aside some time to download and install Confluence 4.0. You can be better prepared by conducting an
upgrade of your data  to see how the upgrade goes. Don't forget to get your internal users (especially the power users)in a test environment
to test out Confluence 4.0. Ask them to go to their complex pages and see what they look like in the new editor and get feedback from them.

3. Give us feedback!

We really would love your feedback as you trial Confluence 4.0. We've made it really easy to do so. All you have to do is simply click the "Got
Feedback" button you see in the Confluence toolbar:
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This feedback will go directly to the Confluence team.

 If you need support, please get in touch with our legendary support department at .support.atlassian.com

4. Upgrade your user macros - Now!

With the introduction of Confluence 4.0, all macros that are inserted in the editor will need to be entered using Macro Autocomplete, or
through the Macro Browser. This includes  too!User Macros

However, a problem with User Macros in the past was that the only way to insert them was if you knew what parameters were available - and
that wasn't documented anywhere. 

Now, if you are running  or higher, we introduced the ability for an Administrator to Confluence 3.4 make their user macros visible in the
. So the good news is you can prepare for that now, without having to wait for Confluence 4.0 toMacro Browser and Macro Autocomplete

ship! How do you do this? You will need to define parameters for your user macros. All the documentation on how to do this can be found
. We've also created  to help you get started.here two examples

  This is required to enable user macros in Confluence 4.0.Important:

6. Test your plugins

Although not all plugins are 4.0 compatible yet, you can still test a majority of your plugins in Confluence 4.0 We strongly recommend you try
this and let Atlassian know if there are any issues. This is really important especially if you have custom plugins that you've built internally.

  All this information for plugin developers can be found from the  How do I migrate my plugins to Confluence 4.0? Planning for
 landing page.Confluence 4.0

Quick Reference Guide for the Confluence Editor
This page is a quick-reference guide to using the Confluence editor. The aim is to give you enough information about the editor's features for
you to experiment yourself, rather than describing every possible shortcut key, autocomplete feature or toolbar option.

This guide is for people who want to use the autocomplete, autoformatting and keyboard shortcuts provided by the editor. If you prefer to use
the toolbar options, the editor itself should be mostly self-explanatory.

On this page:

Introductory Tips
Simple How-To Video
Using the Most Commonly Used Formats and Features

Formatting Text
Using Symbols
Linking Text
Using Lists
Using Tables
Using Macros
Displaying Images and Multimedia

Introductory Tips

1. . The new editor toolbar contains the most important buttons you'llSimply start using the Confluence 4.0 Editor to create your content
need for creating and editing content.

2. . Type these keys in the editor to begin:Use the super-easy keyboard shortcuts

Type  (angle bracket) to insert a link.[
Type  (exclamation point) to insert an image or other media.!
Type  (curly bracket) to insert a macro.{

These controls will autocomplete, prompting you with a list of suggestions to finish off the entry. For more, click the help icon 
on the editor toolbar to see a list of keyboard shortcuts.

3.  To undo something that autocomplete or autoformatting has done, pressDiscover the undo autocomplete and autoformatting actions.
 on your keyboard. Alternatively, press  (Windows) or  (Mac).Backspace Ctrl+Z Cmd+Z

http://support.atlassian.com
http://confluence.atlassian.com/display/DOC/Confluence+3.4+Release+Notes#Confluence3.4ReleaseNotes-UserMacrosinMacroBrowserandAutocomplete
http://confluence.atlassian.com/display/DOC/Confluence+3.4+Release+Notes#Confluence3.4ReleaseNotes-UserMacrosinMacroBrowserandAutocomplete
http://confluence.atlassian.com/display/DOC/Guide+to+User+Macro+Templates#GuidetoUserMacroTemplates-parameters
http://confluence.atlassian.com/display/DOC/Guide+to+User+Macro+Templates#GuidetoUserMacroTemplates-parameters
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Simple How-To Video

Here's a short video showing off the basic editor improvements.

http://youtube.com/watch?v=pd02l91V7cg

Using the Most Commonly Used Formats and Features

Below is a list of the most commonly used editor features, and the related keyboard shortcuts.

Formatting Text

Formatting
Text

What to Do Windows Keyboard
Shortcuts
(For Mac OS X,
replace "Ctrl" with
"Cmd".)

Heading levels Type the heading level and a full stop. Autoformat will convert the line to the appropriate
heading immediately. You can continue typing your heading text immediately. Example:

h2.

Ctrl + 1 to 6

Bold text Type an asterisk '*', your text, then another asterisk. Confluence autoformat will convert the
text to bold immediately. Example:

*Surf's Up*

Ctrl + b

Italic text Type an underscore '_', your text, then another underscore. Confluence autoformatting will
convert the text to italics immediately. Example:

_Surf's Up_

Ctrl + i

Underlined text Type a plus sign '+', your text, then another plus sign '+'. Confluence autoformatting will
convert the text to underlined immediately. Example:

+Surf's Up+

Ctrl + u

Monospace
text

Type two curly braces {{, your text, then another two curly braces }}. Confluence autoformat
will convert the text to monospace immediately. Example:

{{Surf's Up}}

{{

Left, centre
and right
alignment

Click the left, centre and right alignment buttons on the editor toolbar:

 This can also be used to align images independently of text.

None

Indentation Click the left and right indentation buttons on the editor toolbar: Tab ( ), Shift + Tabright
( )left

http://youtube.com/watch?v=pd02l91V7cg
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Quotation Use the  style – select ' ' from the style dropdown menu or use the keyboardQuote Quote
shortcut. Example:

Ctrl + 8

Colour Click the colour options on the editor toolbar. Example: None

Using Symbols

Adding
Symbols and
Emoticons

What to Type Keyboard
Shortcut
(Windows)

Tick or check
mark

Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:

(/)

( + / + )

Smiley Type the globally-recognised markup for a smiley face (colon and round bracket), a wink
(semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:

:)

: + )

Linking Text

Linking text What to Type Keyboard
Shortcut
(Windows)
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Linking to a
Confluence page

Type a square bracket ' ' and start typing the page name to see the suggested pages to link[
to. Press the arrow keys to select the page you want. Example:

[

Linking text to a web
page

Type a square bracket ' ' and select ' ', then paste the URL into the link[ Insert Web Link
dialog. Example:

[

Linking to a page
that does not yet
exist

Type a square bracket ' ' and the name of the non-existent page, then select '[ Insert Link to
'. Example:Create Page

[

Linking to an
attachment

Type a square bracket ' ' and start typing the attachment name to see the suggested[
attachments to link to. Press the arrow keys to select the item you want. Example:

[

Using Lists
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Using lists What to Type Keyboard
Shortcut
(Windows)

Adding a
bullet list

Type an asterisk '*' followed by a space. Autoformat will convert the line to a bulleted list. You can
continue typing your text immediately. Example:

 To add another line of text to an entry without creating a new list item, press Shift + Enter at
the end of the line.

Ctrl + Shift + b

Adding a
numbered list

Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list.
You can continue typing your text immediately. Example:

 To add another line of text to an entry without creating a new list item, press Shift + Enter at
the end of the line.

Ctrl + Shift + n

Using Tables

Using
tables

What to Type Keyboard Shortcut
(Windows)

Adding a
table

Type a series of pipe characters '|' then press . Autoformat will convert the pipes to a table.Enter
Example – to create a table with three columns:

| | | |

None

Using Macros

Adding Macros What to Type Keyboard
Shortcut
(Windows)

Adding a macro
to your page.

Type ' ' and start typing the macro name to see a list of macros that match your text. Press{
the arrow keys to select the macro you want. Example:

{

Displaying Images and Multimedia

Displaying images What to Type Keyboard
Shortcut
(Windows)
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Display an image
attached to the page

Type an exclamation mark ' ' and start typing the image name to see the suggested!
images to insert onto the page. Press the arrow keys to select the item you want.
Example:

!

Displaying an image
attached to another page

Exactly the same as when the image is attached to the same page. !

Embedding multimedia
files

What to Type Keyboard
Shortcut
(Windows)

Embedding a video,
movie or audio file into a
page

Type an exclamation mark ' ' and select 'Insert Other Media'. Example:!

Or type ' ' and start typing the macro name 'Multimedia'. Example:{

!

 

RELATED TOPICS

Using Autocomplete
Planning for Confluence 4.0

Trying Confluence 4.0 Yourself
This page describes the ways you can try Confluence 4.0 yourself, including the new editor.
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To try out Confluence 4.0, . Once installed, you can create and edit pages using the new Confluence 4.0download the latest EAP release
editor (and other features in their current state).

All Confluence users are welcome to try out Confluence 4.0 and submit some feedback to the Atlassian developers! We value your input.

RELATED TOPICS

Planning for Confluence 4.0

Confluence 4.0 Editor FAQ
Confluence 4.0 Editor - What's Changed for Users of the Old Rich Text Editor
Confluence 4.0 Editor - What's Changed for Wiki Markup Users
Quick Administrator Tips To Prepare for Confluence 4.0
Quick Reference Guide for the Confluence Editor
Trying Confluence 4.0 Yourself
Wiki Markup to XHTML Migration

Wiki Markup to XHTML Migration
If you are upgrading to Confluence 4.0 from an older version, then as part of the upgrade an automatic migration of your site will take place.
This is a non-destructive process. Your existing content is not overwritten: instead a new XHTML version of each Wiki Markup page will be
created. In saying that, you must still be sure to perform a backup of your database and home directory prior to starting the new version of
Confluence. Of course, that is our standard recommendation for any .Confluence upgrade

Migration Process
Migration Logging
Re-running Migration
Re-attempt Migration

Migration Process

Depending on the size of your Confluence install, the Wiki Markup to XHTML migration could prove time consuming. The duration of the
migration is difficult to estimate; this is due to a number of site specific factors. As a rough guide, a test dataset we migrated was 130,000
pages, totalling approximately 700Mb, which took six minutes.

There are certain properties that can be modified to allow finer control over the migration process.

Property Purpose Default

confluence.wiki.migration.threads The number of concurrent worker threads migrating content 4

confluence.wiki.migration.batch.size The number of items migrated in each batch of work 500

confluence.wiki.migration.versioncomment The comment associated with the newly migrated version of each
piece of content

"Migrated to
Confluence 4.0"

(For instructions on setting Confluence system properties see .)this document

Again, due to the large variability in Confluence installations it is hard to give specific recommendations for the above settings. One point to
note though that both increasing batch size and the number of threads (or both) will increase the peak memory required for migration. If
memory is an issue then as you increase one of these settings consider decreasing the other.

Another factor to be aware of if modifying these defaults is that of the cache settings employed in your site. The migration will quickly
populate certain Confluence caches so be sure that if you have customised caches as  that there is enough memory on thedescribed here
server for these caches should they reach maximum capacity.

To monitor the progress of a site migration you should watch the output in the .application log

Migration Logging

Typical logging progress will be shown by multiple log entries at the INFO level of the format -

WikiToXhtmlMigrationThread-n - Migrated 2500 of 158432 pages, this batch migrated 500/500
without error

There may be a wide array of messages logged from each individual page but any errors are also collected for display in a single migration
report once all content has been processed. A typical example of such a report is -
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Wiki to XHTML Exception Report:
Summary:
 0 settings values failed.
 0 PageTemplates failed.
 2 ContentEntityObjects failed.
Content Exceptions:
 1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause:
com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException:
The macro link is unknown.. Message: The macro link is unknown.
 2) Type: comment, Id: 6919, Title: null, Global Scope. Cause:
com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException:
The macro mymacro is unknown.. Message: The macro mymacro is unknown.

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to XHTML but actually consisting of Wiki Markup content
wrapped within an XHTML specific 'unmigrated-wiki-markup' macro. This content will still be viewable in Confluence and editable within the
new Confluence Editor.

However, in some cases a batch of content may actually have completely failed to migrated. This is most typically due to an unhandled
exception causing a database transcation rollback. This would be reported in the log with a message like -

Unable to start up Confluence. Fatal error during startup sequence:
confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the upgrades that require
the plugin framework to be available) -
com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException:
java.util.concurrent.ExecutionException:
org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it
has been marked as rollback-only

The current version of Confluence 4.0 provides  about this scenario and will also allow Confluence to restart as normalno further report
without retrying a migration. Should a user try to view any such unmigrated content they would see an exception similar to -

java.lang.UnsupportedOperationException: The body of this ContentEntityObject ('Page Title')
was 'WIKI' but was expected to be 'XHTML'

The solution here is to ensure you manually re-run the site migration after the restart.

Re-running Migration

A Confluence Administrator can restart the site migration should there have been any content found to have failed migration (see previous
section). Only the content that is still found to be Wiki Markup formatted will be migrated so typically a re-migration will take less time than the
original migration.

To manually re-run migration:

Open <site>/admin/force-upgrade.action
From the 'Upgrade task to run' list select wikiToXhtmlMigrationUpgradeTask
Click 'Force Upgrade'.

Re-attempt Migration

The previous section was about dealing with the exceptional circumstance where certain content was left completely unmigrated. The most

https://jira.atlassian.com/browse/CONFDEV-499
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common migration problem is that the content was migrated but remains Wiki Markup within the body of an 'unmigrated-wiki-markup' macro.
This is the state any content which is references in the migration report will be found in. This content is still viewable and editable but since it
is Wiki Markup it cannot be edited using the full feature set of the new Editor.

The most common reason for content to be in this state is that a non 4.0 compatible macro (or unknown macro) was found on the page.

There are two possible fixes for this situation -

Install a 4.0 compatible version of the macro. See .Plugin Development Upgrade FAQ for 4.0
Edit the page to no longer use the problematic macro.

Regardless of the solution you choose, you can then force a re-migrated of all the content that was left wrapped in an
'unmigrated-wiki-markup' macro. This feature is found at <site>/admin/unmigratedwikicontent.action

https://developer.atlassian.com/display/CONFDEV/Plugin+Development+Upgrade+FAQ+for+4.0
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